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Chapter One: Introducing the Speed Survey
Analysis System

1

The Crossroads Software Speed Survey Analysis System is an integrated software 
package for summarizing, analyzing, and documenting the results of speed surveys.  
Built around the State of California Vehicle Code (CVC) requirements for engineering 
and traffic surveys, the Speed Survey Analysis System provides all of the information 
needed to support speed limit postings.  The key components of the package include:

1. Data collection sheets that allow you to quickly document speed measurements and 
conditions taken in the field.

2. Data input module for adding your speed measurements by location into the 
integrated database.

3. A grid summary form that automatically places the speed data in a standard grid 
sheet format and calculates the critical statistics needed for determining the proper 
speed limit posting, including the 85th, 50th, and 15th percentile speeds and the ten 
mile per hour (MPH) pace, along with the number and percent in the pace.

4. A single page engineering and traffic summary that automatically accesses and 
summarizes the prevailing speed data from the database and provides a data entry 
screen for inputting accident history, traffic factors, and physical conditions not readily 
apparent to the motorist.

5. Ability to create and display speed zones using ESRI’s ArcView.

The advantages of the Speed Survey Analysis System are the accuracy and 
completeness of the information provided by the database, its ease of use, and the 
reduction in time needed to perform one or multiple surveys.

1.1 Using the Speed Survey Analysis System

The Speed Survey Analysis System is a productive, easy-to-use program that runs in 
the familiar Microsoft Windows environment.  If you are familiar with Windows-based 
programs, you will find the Speed Survey Analysis System simple and intuitive; and if 
you are not familiar with Windows-based programs, you will still find it simple and 
intuitive!

The program itself was developed in Microsoft Access, but you do not need to have 
Access already.  Crossroads Software supplies a “run-time” version of Access.
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The Speed Survey Analysis System and the Traffic Collision Database System
The Speed Survey program comes as a stand-alone package or as a supplement to 
Crossroads Software’s Traffic Collision Database System.  The essential features of the 
Speed Survey program work even if you do not own the Collision Database, but there 
are some additional features that only work with the Collision Database, including GIS 
mapping and access to average daily traffic (ADT) volumes.  

Also, if you already have the Collision Database System, the street name tables and 
segment lengths will be incorporated into the Speed Survey System.  If you don’t have 
the Collision Database, the street names will need to be inputted into the Speed Survey 
System.  Nevertheless, the Speed Survey System perform all of its essential functions 
when used as a stand-alone product.

Features of the Speed Survey Analysis System
The Speed Survey program is very intuitive and straightforward.  Use the on-screen 
buttons to navigate from one section of the database to another.  The main menu (Fig. 
1.1) is the single point of entry for all features of the system; select an option by clicking 
on a button.

Fig. 1.1
Click on the buttons to navigate through the system.

When using the main input form for a speed survey location, you can enter data into any 
field by clicking in that field with the cursor or, what is even easier, use the <Tab> key to 
move from one field to the next (<Tab> is often the easiest because you’ll be typing in 
data already, and it’s simply one more keystroke).
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A standard feature of all of Crossroads Software’s products is the drop-down menu.  A 
field with a down-arrow on its far-right border has a drop-down menu which contains 
pre-configured or user-configured data.  Selections can be made from the drop-down 
list by clicking on the down arrow, locating the appropriate data, and then clicking on the 
data in the list to select it and input it in the field (you can also use the <F4> key to open 
the drop-down menu).

A related feature is what is called “auto-match,” which exists in fields that have drop-
down menus.  As you type in letters, the system finds potential matches and places 
them in the field.  When it brings up the match you need, just hit <Enter> to accept it 
and move to the next field.  “Auto-match” is a great device because it saves you a 
significant amount of time (not to mention the fact that it saves your fingers from 
exhaustion!).  For example, let’s say you type in “e” and then “u” in the street name field; 
you might see “euCALYPTUS DRIVE” filled in (the system fills in the “CALYPTUS 
DRIVE”).  If Eucalyptus Drive is the street name you want, just hit <Enter>.  If you 
continue typing letters, the system will find other potential matches.  Entering “c” after 
the “e” and “u” might give you “eucLID AVENUE.”  Hit <Enter> if that is the match you 
need, or keep typing.  (Note: if the data you type in is not contained in the drop-down 
menu, chances are there was an error in recording the data or the drop-down menu 

Fig. 1.2
Blank field with drop-down menu closed.

Fig. 1.3
Blank field with drop-down menu open.  Scroll through the menu and make a selection.

Fig. 1.4
The auto-match feature at work; the letters “E” and “U” have been typed in, and 
the system fills in a possible match, spelling “Eucalyptus Avenue.”
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Inputting Dates and Times
When inputting dates and times into the Speed Survey Analysis, be sure to use the 
standard formats.  For dates, the format is eight digits.  For example, March 2, 2001 
would be entered as “03/02/2001.”  The system automatically includes the slashes.  For 
time, the format is four digits.  Nine-thirty in the morning would be entered as “09:30.”  
The system automatically inputs the colon.
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Chapter Two: Configuration 2

Crossroads Software’s Speed Survey Analysis System can be configured to suit the 
particular needs of your agency.  You can customize the actual distances that are 
surveyed, the headings of reports, and the data for weather, lanes, road conditions, 
roadway geometrics, and more.  

To access the Configuration screen shown in Fig. 2.1 below, just hit the Configuration 
button in the Speed Survey Analysis Main Menu.

Fig. 2.1

2.1 Configuring Distances for Collision Summaries

The Configuration option allows you to include or exclude collisions within specified 
distances on a primary road between two limits (or cross streets).  For example, you 
can setup the program to survey only those collisions that occurred on Main Street one 
hundred feet from First Street (Limit 1) and one hundred feet from Second Street (Limit 
2).  In addition, you can also set intermediate distances.  Say that you are surveying 
speeds on Main Street and your limits are First Street and Fifth, but there are four 
intersections between those two limits.  You can set one distance that applies to each of 
those intermediate intersections.
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To set the distances, you must first specify whether the system should include distances 
greater than or equal to (>=) the ones you set or just greater than (>) the one you set.  
Then you input the specific distance measurement.  

Select greater than or equal to (>=) or greater than (>) by using the drop-down menu.

Fig. 2.2
Set Greater Than or Equal To (>=) or Greater Than (>)

Fig. 2.3
Set the Distance in Feet.

Distances can be set for All Collisions and for Rear-End collisions, which occur on the 
approach to an intersection.  In addition, the Configuration screen has distances 
settings for two limits and a midblock segment: Limit 1 Distances, Limit 2 Distances, 
and Intermediate Distances.

Distances, as you can probably guess, are measured in feet; by default, all of them are 
set at zero (0).  Once you change any or all distances, the system automatically saves 
the new settings.
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2.2 Report Headings

The reports that you can run in the Speed Survey Analysis System have headings while 
the Summary Report has a footer.  The headings and the footer can be configured to 
state whatever you want them to, although chances are you will have them include your 
public agency’s or your department’s name or something similar.  For example, the first 
heading might read “City of Hill Valley.”  The second might read “Traffic Engineering 
Department.”  And the footer, which specifies who approved and authorized the report, 
might read “City of Hill Valley Traffic Engineering Division.”

Fig. 2.4

To input new headings and the footer or to change existing information, just type in the 
headers and footer that you want.  The system will keep the information you type in.

2.3 Configuration Tables

The Study Location input form, which is the main input form in the Speed Survey 
Analysis program, has a series of drop-down menus that contain pre-configured data.  
These menus give you choices for data that relate to traffic lanes, roadway geometrics, 
road conditions, weather, and other road and speed information.

The data in these input menus are contained in data tables, which can be customized to 
suit your specific needs.  You can add, edit, or delete the data in the tables, and when 
you open the Study Location form again, you will see the changes reflected in the drop-
down menus.

Currently, Configuration allows you to customize the tables for: Comments, Traffic 
Lanes, Roadway Geometrics, Roads, Expected Accident Rates, Weather, Adjacent 
Land Use, Conditions Not Apparent, and Street Classification.

There’s an additional option to Confirm Tables Are Attached.  We’ll look at that later.
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Example 1: Lane Configuration
We won’t go through every configurable table because all the tables work essentially 
the same way.  Instead, we’ll take a look at a few examples to show you the process of 
editing a data table in the Speed Survey Analysis System.

Take a look at Fig. 2.5, which shows the Lane Configuration Table.

Fig. 2.5

The table contains rows of cells, and each cell contains data.  To edit a piece of data, 
simply click in its cell and begin typing.  

Notice that at the left of each cell is a small, gray “tab”.  In Fig. 2.5, the gray tab for the 
first cell has an arrow in it.  Click on a tab to highlight the entire cell.  You can then 
delete the cell by hitting the <Delete> key.  

To add new data to the list, click in the blank cell at the bottom.  Input the new data and 
hit <Return>.  Once you hit <Return>, a new blank cell should appear at the bottom.  If 
you have more data you want to add to the table, simply repeat this process.

You’ll see the data table in action when using the Survey Location input form.  The Lane 
Configuration field has a drop-down menu that contains all of the data originally 
configured in the Lane Configuration table.

Fig. 2.6
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Another example of data table configuration is Roadway Geometrics.  Like the previous 
example, this data table configures a drop-down menu for the input form.

Fig. 2.7

Take a look at the table in Fig. 2.7 above.  The data in the table appears in the Roadway 
Geometrics drop-down list in the Survey Location input form:

Fig. 2.8

As in the previous example, simply click in a cell to change the data, or click on the gray 
tab to highlight the entire cell; then hit the <Delete> key if you want to delete the data 
entirely.

To add new data, input it in the blank cell at the bottom and hit <Return>.  Repeat this 
process if necessary.

After configuring the data table, just click on the Exit button to close the table and have 
the system save your new configuration.

Fig. 2.9

The other configuration tables work the same way.  Customize as many as you need 
and, when finished, simply click the exit button in the Configuration screen to return to 
the Speed Survey Analysis Main Menu.
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Attach Speed Study Tables
The Speed Survey Analysis System uses Microsoft Access Database tables to store, 
manage, and query data.  These tables must be attached properly upon installation in 
order for the program to run correctly.  The system will alert you automatically with the 
message: “Unable to attach the necessary speed study tables.”  It will then ask for each 
study table (each file has a .mdb extension): speeds.mdb, streets.mdb, counts.mdb, 
and collisn.mdb.  The system will bring up this message box:

Fig. 2.10

Click “OK” to bring up a dialog box that allows you to locate and select the Speeds.mdb 
file (Fig. 2.11).

Fig. 2.11

Locate the Speeds.mdb file by navigating through the folders on the right.  To select the 
file, click on it in the list on the left.  The file will appear in the File Name field at the top.  
Click OK.

Repeat the same process for the remaining .mdb files.  The system will automatically 
ask you to attach each one.

To check if all the data tables are properly attached, click on the Confirm Tables Are 
Attached button in the Configuration menu.  The program will tell you which tables have 
not been attached and will allow you to attach them.
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Confirm Tables Are Attached
Crossroads Software’s Speed Survey Analysis System can pinpoint survey locations on 
a color-coded, editable GIS map.  In order for the GIS feature to work properly, the GIS 
data tables must be attached properly to the Speed Survey program.

Clicking on the Confirm Tables are Attached button will have the system check 
whether or not the GIS data tables are attached properly.  

If they are not attached, the system will display a message and ask you to locate the 
aat.dbf file on your computer’s hard drive.

Fig. 2.12

A Windows dialog box opens.  Navigate to the Crossrds folder, then to the Gis folder, 
and then look for the aat.dbf file.  The files will appear on the left.  Select the aat.dbf file 
by clicking on it and then hit the OK button to accept the file.

The system will then prompt you that the ArcView table has attached properly.

If, for some reason, the tables do not attach, the system will warn you that attaching the 
tables failed.  You can try again.  Contact Crossroads Software at (714) 990-6433 if you 
still cannot attach the tables.

Check Lengths and Rates
This option (located at the top right of the screen just below the Exit button) checks 
segment lengths and collision rates at all locations.  It’s a diagnostic tool for older 
versions of the software; so you won’t need to use this option unless it’s necessitated by 
Crossroads Software.

The system runs a check on the lengths and rates and then displays a small dialog box 
with the accident rate.  View the accident rate and then click OK.  The Speed Change 
Table opens.  This easy-to-read table gives old and new segment lengths and old and 
new accident rates for each segment.

The Speed Change Table report can be printed out or can be output to an external file.  
Just click on the File menu at the top and choose an option.  Output To will prompt you 
to select a file format (.xls for an Excel spreadsheet, .rtf for a rich-text file, and .txt for a 
text file).  After selecting a format, give the file a name and specify where the file should 
go on your computer.
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Chapter Three: Study Locations 3

3.1 Study Locations

Study Locations represents the heart of the Speed Survey Analysis System.  With this 
feature, you can input and edit Study Location reports, produce grid and summary 
reports, query for collisions, and more.  Virtually everything you do in the Database will 
be done in the Study Locations section.

Study Locations employs a very straightforward interface for its input form, providing 
easily navigable buttons and easily understandable input fields.

Click on the Study Locations button in the Main Menu.  The first screen is a list of all 
existing locations in the system.  If no locations have been entered at all, the list will be 
blank.  Once you begin inputting new study location records, they will appear here.

Fig. 3.1

In addition to the list of existing study locations, there are two main options: Edit 
Location and Create New Location.  Edit Location requires that you select a record 
from the list; the system will then open the record and allow you to edit the data and 
produce reports.  Create New Location opens a blank study location input form and 
allows you to input data for a new record.

We’ll begin with create new records and then look at how to edit them.

Click the Create New Location button and then head to section 3.2 to read about 
creating records.
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3.2 Create New Study Location

Fig. 3.2 shows a blank Study Location input form.

Buttons for reports. Speeds options.

Input fields. Additional options.

Fig. 3.2

When the input form opens, the cursor is in the Date field.  When inputting data in the 
fields, use the <Tab> key to move from one field to the next, taking advantage of drop-
down menus where they are available.  For dates, keep in mind that you must use the 
standard eight-digit format (January 1, 2001, for example, would be entered as 
“01/01/2001”); for time, you must use the four-digit format (9:30AM would be entered as 
“09:30”).

Input Fields

Date.  Input the date.  The system will advance you to User Location#.

User Location#.  Input the number and hit <Tab> to continue.

Street.  Between.  And.  These fields are for inputting the primary arterial and two 
limits.  Use the drop-down menus to select the street names or type in the names and 
let auto-match go to work.  See Fig. 3.3 below.
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Keep in mind that if you do not have the Traffic Collision Database, the 
street names will not appear in the drop-down menus.  This is because the 
Collision Database contains street tables containing all the streets in your 
city (or county).  When using the Speed Survey Analysis System as a 
stand-alone product, the street names need to be inputted in the form 
manually.

Note

Fig. 3.3

First, input a street name in the Street field.  The cross streets in the Between and And 
fields won’t appear in the drop-down menus until you have selected a primary street.

Once you have selected a street, input the limits.  The Between and And fields contain 
only those streets that cross the primary street.

Fig. 3.4

In Fig. 3.4, a primary street has been entered, and the open drop-down menu displays 
the available cross streets.

After selecting a street in the And field, the system automatically calculates the segment 
length and inputs it in the Segment Length field.

Fig. 3.5
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When you have finished with the Street, Between, and And fields, hit <Tab> to advance 
to Observer.

Observer.  Input the name of the observer and hit <Tab> to continue.

Location of Survey.  In this field, write in the address where the survey took place.  
Then hit <Tab>.

Weather.  Select the weather (Clear, Cloudy, Raining, etc). from the drop-down menu.

Road Condition.  From the drop-down menu, select a road condition.  Hit <Tab> to 
continue.

Posted Speed.  Input the posted speed (e.g., 35 MPH), then <Tab> over to Lane 
Config.

Lane Config.  Specifies the lane configuration of the segment being surveyed.  Select a 
configuration from the drop-down list.

Adj. Land Use.  (Adjacent Land Use.)  Select one of the options (Commercial, 
Business District, Single Family Residential, etc.) from the drop-down menu.  

Roadway Geometrics.  Input a roadway geometric.  Hit <Tab> to continue.

Conditions Not Apparent.  This is for designating any existing conditions that aren’t 
apparent to motorists but that can nevertheless influence driving on the designated 
roadway.  Use the drop-down list to select a condition.  Remember that the conditions 
are configurable.  See Chapter Two for more details on configuring input data.

Start Time.  Input a start time using the regular time format (four digits, as in “09:30”).  
The system will automatically advance you to End Time.

End Time.  Input the end time.  The cursor automatically jumps to the next field.

Fig. 3.6
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Street Classification.  Fig. 3.6 shows the Street Classification drop-down menu.  
Select the appropriate classification and hit <Tab> to advance to the next field.  Of 
course, you can always type in the classification and let auto-match help.

ADT.  Input the Average Daily Traffic Volume (ADT Volume) here.  You should already 
have the data for the ADT, but if you do not, and if you are using Crossroads Software’s 
Counts program, you can hit the Lookup ADT Volumes button on the right of the 
screen to obtain the ADT volume (if the Speed Survey Analysis System is not 
connected to the Counts module, you won’t be able to lookup the ADT volume).

Segment Length.  The system will calculate and input the segment length when you 
input street names in the Street, Between, and And fields.  If the system did not input 
the segment, you can enter it here by hand.

Speed Limit Changed.  A simple “Yes” or “No” field.  You can just type in the first letter, 
either “Y” or “N,” and the system will fill in the rest.  Hit <Tab> to continue.

Revised Speed Limit.  If the speed limit has been changed, input the revised speed 
limit here.

Checked By.  Type in the initials of the individual who has checked the survey location 
information.

Comments.  This text box can be used to write specific comments about the survey 
location.  If there are recurring comments that you use on a regular basis, you can set 
them up in the Comments configuration table.  Please refer to chapter two for details on 
using the Configuration option.  Fig. 3.7 shows the Comments field.

Fig. 3.7

You are not limited to the comments in the drop-down menu.  You can type in any 
comments you wish.  The configurable drop-down list is just a convenient way to select 
recurring comments without having to type them in time and again.

Include in Summary Report.  Check this box (to the right of the Comments field) if you 
want to include the current survey location in the Summary Report for all locations (we’ll 
look at the Summary Report a bit later).

Used to Set Limit.  Check this box (also to the right of the Comments field) if the 
survey location study for the current record was used to set the speed limit.  If it was, 
and if you check the box, the Summary Report will read “Yes” under the heading “Study 
Used for Limit?”  We’ll look at the Summary Report later.
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Inputting Total Collisions and Calculating Collision Rates

The remaining input fields in the new survey location form are for inputting the total 
number of collisions that took place during a specified period for the location, calculating 
the collision rate, and then comparing the actual collision rate with expected collision 
rates.

Fig. 3.8

Collision Start Date.  Enter the beginning date using the eight-digit format (e.g., 
“03/02/2001”),

Collision End Date.  Enter the end date.

Collision Period.  This is measured in numbers of years.  Input the number of years 
and then hit <Tab> to advance to Total Collisions.

Total Collisions.  If the Speed Survey Analysis System is connected to the Traffic 
Collision Database, you can use the Query for Collisions feature (the button just to the 
right of the Collision Start Date field) to calculate the Total Collisions and the Collision 
Rate.  The system will pull data from the Collision Database for the location during the 
dates you specified and then input that data in the Total Collisions and Collision Rate 
fields.

Keep in mind that if you use Query for Collisions, the system will query what is 
essentially a midblock segment, running between the two limits you set in the Between 
and And fields.  The exact distances from the intersections of the limits and the primary 
street can be set in Configuration.  See Chapter Two for details on setting distances.

If you are using the Speed Survey Analysis System as a stand-alone program, you will 
have to enter the Total Collisions data by hand.  Input in this field and then <Tab> over 
to Collision Rate.

Collision Rate.  If you used the Query for Collisions feature (see explanation for Total 
Collisions just above), the system will input the Collision Rate for you.  If you input the 
Total Collisions by hand, the system can still calculate th rate for you.  Simply hit the 
Calculate Collision Rate button just to the right of the Collision Rate field and let the 
system go to work for you.
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Fig. 3.9

Fig. 3.9 above shows the collision data in the input fields.  Once the system has 
calculated the Collision Rate, you can input the Expected Collision Rate to help you 
determine if the rate is higher or lower than what is normally expected for the type of 
segment you are currently surveying.

Expected Collision Rate.  Using the drop-down menu, select an expected collision rate 
based on the type of segment (2 or 3 Lane Urban Road, 4 or More Lane Urban Road, 
etc).  The expected collision rates are pre-configured, and you can setup and customize 
them in the Configuration section of the Database (see Chapter Two for more details).

Fig. 3.10

Other Options

Right next to the collision input fields are two report options: Print Grid Report for All 
and Print Summary Report All.  Both calculate statistics and print a report for every 
location in the database.  This can be a time consuming process, particularly when 
printing, although the amount of time depends on how many records there are in the 
database.

Before the system runs the statistics and prints the report, it will prompt you with this 
message: “Calc Stats and print the Location Summary Report for each location in 
the database? Note: printing each location could be time consuming.”  If you want 
to continue, click “Yes.”

If you decide not to calculate the stats and print the report, just select “No.”
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3.3 Input and Edit Speeds and Produce Survey Reports

Take a look at the top of the survey location screen:

Fig. 3.11

This system, obviously, is for speed survey analysis, and the options at the top of the 
screen are where the analysis really comes into play.  So far, you have inputted a speed 
survey location.  The next step is to input the speeds from the survey itself and then 
have the Database produce reports that breakdown the speed data for you.

Collecting speed data involves surveying traffic at a specific location and recording 
speeds.  The Data Collection form and the Blank Grid Report are designed for these 
purposes.  Click on the Data Collection button to print a blank collection form and on the 
Blank Grid Report button to print a blank grid report.

The system opens the report in “print preview.”  Click on the File button at the top and 
select Print Report to send the blank form to your printer (see Fig. 3.12)

Fig. 3.12
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Use the Data Collection form and the Blank Grid Report to collect speed measurements 
in the field.  You can then input the speed data using the Input/Edit Speeds and 
Input/Edit Multiple Speeds options.

Of course, if you are inputting a new speed survey record, you will only be inputting 
speeds.  We’ll cover editing speeds, as well as editing survey records, in section 3.5.  
For now, let’s look at the input side of the process.

The Grid Report and Location Summary buttons produce the survey analysis reports, 
which should be run after inputting the speed data.

Input Speeds
To input speeds, you must first open the Direction drop-down menu and select a 
direction: North, South, East, West, North/South, or East/West.  Then select from one of 
the two options: input speeds or input multiple speeds.

Fig. 3.13
Select a direction and then choose to input single or multiple speeds.

So what’s the difference between “input speeds” and “input multiple speeds”?  Well, it all 
depends on how you have collected the speed data.  If you used a grid report to take 
speed data, you marked down how many vehicles were traveling at a specific rate of 
speed; e.g., how many cars traveled at 35 MPH along the specified segment, how many 
traveled at 40 MPH, and so on.  In other words, you catalogued “multiple speeds.”

On the other hand, if you used the Data Collection form, you marked down each 
vehicle’s speed as it went by, simply marking the speeds of vehicles in consecutive 
order.  Therefore, you will input the speeds in the Database one-by-one, and then let the 
Database group them in multiples.

Either way, the speeds need to be inputted separately for each direction.  For example, 
if you have speeds for a segment running north and south, input the north-bound 
speeds and then the south-bound speeds (or vice versa).  If you’ve collected speeds 
only for one direction of the segment, then, naturally, you’ll input only those.

Let’s see how this works by looking at the speed input screens, beginning first with 
“single speed” input.
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Fig. 3.14

Input a speed in the first speed input field (the cursor will be there automatically), and hit 
<Tab>.  The system inputs the direction just to the right of the speed and advances you 
to the next line.  Continue inputting the rest of the speeds.

Fig. 3.15

When you have finished inputting the speeds, click on the Exit button to save the speed 
data and return to the survey input form.

Inputting multiple speeds is a similar process, except there’s one extra step.  You first 
enter the multiple, followed by the speed.  For example, if you have recorded five 
vehicles traveling at 35 MPH, you would input the “5”and  then <Tab> to the next field 
and input the speed; the system will input the direction and advance you to the next line.  

Fig. 3.16
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Fig. 3.16 above shows a list of multiple speed data.  There’s a multiple of three for 33 
MPH, a multiple of five for 34 MPH, three at 39 MPH, nine at 40 MPH, and so on.  

Simply fill out the form with all of the multiple speeds and, when you are finished, click 
the Exit button.  The system will save the data and return you to the survey input form.

The two input options work in conjunction.  If you input single speeds, the 
system stores them in the multiple speeds form, adding up how many 
occurrences you have of the same speed, marking unique speeds with a 
multiple of “1”.  If you input multiple speeds, then the system breaks them 
down as single speeds for the single speed input form.  You can test this 
by inputting speeds in one way and then opening the other form.  After 
inputting speeds one-by-one, click on the Input/Edit Multiple Speeds button 
to view the speeds as multiples, and vice versa.

Note

3.4 Grid and Location Summary Reports

The Grid and Location Summary Reports are convenient, easily generated speed 
survey reports that breakdown and analyze the speed data for specific locations.  Your 
agency can use these reports to study speeds and to recommend speed limit changes. 
The Grid Report not only displays plotted speeds, but it also includes percentiles 
(particularly the 85th, 50th, and 15th percentiles), pace information, road conditions, and 
more.  The Location Summary offers a variety of speed data, from percentile and pace 
information, to collision rate, to traffic factors (such as Lance Configuration and Street 
Classification).

You can’t run a Grid or a Location Summary Report until you have completed a speed 
survey location form and have inputted the speeds (the system needs data in order to 
produce reports).  You can run the reports for speed survey location records that 
already exist in the system.  When you select a specific record from the Study Locations 
list (see Fig. 3.1) and click on the Edit Location button, the system opens the record; 
you can then run the reports.

Just select a report from the options at the top.

Choose either Grid Report or Location Summary.

Fig. 3.17
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Fig. 3.18
Sample Grid Report
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Fig. 3.19
Sample Location Summary Report
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What’s in the Grid Report
The Grid Report simply displays a grid of all the inputted speeds.  The numbers listed 
vertically on the left (the “y” axis) represent the speed, while the numbers listed 
horizontally at the top (the “x” axis) represent the totals.

On the right of the grid are three columns.  The first (#) lists the total for each speed; the 
second (%ea) includes what percentage of the total each speed represents, and the 
third (cum.%) includes the cumulative percentage for each speed.  The cumulative 
percentage is calculated by setting the highest recorded speed for a segment at 100% 
and then ranking the remaining speeds.  The cumulative percentage provides 
information for the 85th, 50th, and 15th percentile speeds, which help agencies 
determine if a speed limit change is necessary.

At the bottom you’ll find details of the report:

Fig. 3.20

The box on the left includes the percentile and pace information.  The larger box on the 
right provides survey date and time information, along with Road Condition, Posted 
Speed, Street Class, Conditions Not Apparent, and the initials of the observer.

What’s in the Location Summary Report
While the Location Summary Report includes some of the information found on the Grid 
Report, it’s really a different type of report.  It basically summarizes all the survey data 
for a location places them in the proper categories.  So, for example, the Prevailing 
Speed Data category provides percentile, pace, and posted speed limit information.  
The Collision History section covers a date range, total collisions, collision rate, and 
the expected collision rate (what’s expected for a segment of that type).

The Location Summary Report also categorizes Traffic Factors, including the Average 
Daily Traffic volume, segment length, lane configuration, and street classification.  
There’s also a section for Conditions Not Readily Apparent, which contains details on 
roadway conditions and geometrics, as well as additional comments relating to the 
survey.

Finally, there’s a category for Adjacent Land Use, and, at the very bottom, the report 
indicates if a speed limit change has or will be made and what the revised speed limit is.
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Options in the Reports
Once you run a report and it’s displayed on screen, you have the option of printing it or 
of outputting it as a txt, rtf, or xls file.

Click on the File menu at the top of the screen and select Print Report to send the 
report to your printer.  

Select Output To if you want to output the report into a separate file.  A dialog box will 
appear, prompting you to select the file type (txt, rtf, or xls) and then select a location 
where it will be saved.  

Fig. 3.21

To close the report and return to the survey location screen, just open the File menu and 
click on Close.

That’s essentially how reporting in the Speed Survey Analysis works, although there’s 
one major summary report, as well as a GIS mapping component.  Head over to 
Chapter Four to learn about these options.

Continue to Section 3.5 to learn how to edit Speed Survey Location records and 
speeds.
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3.5 Edit Speed Survey Locations

Speed Survey Location records that already exist in the system can be edited and then 
re-entered into the system.  You can edit any and all data in the record, including the 
speeds data.  The process is very simple.  Locate the record you want to edit in the 
Speed Survey Location list and the click the Edit Location button.

Fig. 3.22

The system then opens the selected record.

Fig. 3.23
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To edit the record, just click in the field(s) containing the data you need to change or 
delete.  Make the change by typing in new data or selecting data from a drop-down list 
(where available).  You can also navigate through the form by using the <Tab> key, just 
as you did when creating a new location.  And you can add data to blank fields.

Once you have finished editing the record, click on the Exit button at the top right of the 
screen.  The system saves the changes and then takes you back to the Speed Survey 
Location list.

Editing Speeds
The Speed Survey Analysis System is so flexible that even the speeds can be changed.  
First, select the record you want to edit from the Speed Survey Location list (Fig. 3.22 
above).  Next, input a direction in the Direction field just below the Input/Edit Speeds 
button.  Then click on Input/Edit Speeds to edit single speeds, or, if you want to edit 
multiples, just click on the Input/Edit Multiple Speeds.

Fig. 3.24 below shows the multiple speeds screen.

Fig. 3.24

Use the <Tab> key to navigate across the rows in the form or simply click in the cell 
containing the speed(s) you want to edit.  Any and all multiple speeds can be edited, 
and you can also add additional speeds if necessary.  Keep in mind that speeds are 
inputted according to direction, so to view or edit all the speeds, you need to select each 
direction and then click one of the Input/Edit Speeds buttons (for example, if the 
segment runs north and south, you have to edit the north-bound speeds separately from 
the south-bound speeds).
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Once you have changed the speeds data, click the Exit button to return to the Speed 
Survey Location form.  You can edit the data in the form or, if not, close the form by 
clicking on its Exit button at the top right.  Exiting will take you back to the Speed Survey 
Location list.

Well, that’s editing in a nutshell.  It’s not very difficult at all.  Remember that any and all 
records in the system can be edited.  This provides you with a great deal of flexibility 
with your records.

The following chapter explains the Summary Spreadsheet Report and the GIS mapping 
component.
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Chapter Four: Summary Spreadsheet and GIS 4

The Speed Survey Analysis System’s main menu offers Study Locations and 
Configuration Menu features, but it also offers the Summary Spreadsheet and an option 
to Highlight on GIS Map.  The Summary Spreadsheet is a printable spreadsheet report 
of all the speed survey locations in the system.  The Highlight on GIS Map feature 
works in conjunction with Crossroads Software’s Traffic Collision Database and 
highlights the survey locations on a GIS map that can be viewed in ESRI’s ArcView (the 
ArcView software comes with the Traffic Collision Database).  If you are using the 
Speed Survey Analysis as a stand-alone product, GIS mapping is not an option.

4.1 Summary Spreadsheet

Simply click on the Summary Spreadsheet button in the main menu of the Speed 
Survey Analysis System to run the report.  Because the spreadsheet includes all the 
survey locations, it takes a few moments for the program to produce the report.

The system first prompts you to confirm that you want to run the entire report, asking, 
“Calc Stats and show the Summary Table for all locations in the database?”  Click “Yes” 
to continue.  

After a few moments, the program displays the report.  It will comprise several pages, 
although the exact number of pages will vary depending on the number of locations in 
the database.  You navigate from page to page using the arrows in the bottom left of the 
screen (the outer arrows take you to the first and last pages, while the inner arrows take 
you from page to page).

The Summary Spreadsheet includes: 
Location The segment and two limits.
Date The date of the survey.
Direction The direction of the segment (north/south or east/west).
50th The 50th percentile speed.
85th The 85th percentile speed.
Accident Rate The actual accident rate for the location.
Expected Accid. Rate The expected accident rate for the location.
Posted The posted speed limit.
Limit Change “Yes” or “No” will indicate if there’s been a limit change.
New Limit Indicates the new speed limit (if applicable).
Study Used for Limit? “Yes” or “No” will indicate if the speed study was used

for the limit at each location.

Fig. 4.1 on the following page shows a sample Summary Spreadsheet (note that it’s not 
actual size).
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The report can be printed by simply opening the File menu at the top and selecting 
Print Report.  The Output To option lets you save the report as a txt, rtf, or xls file (text, 
rich text, or Excel file), so that you can save the report on your computer for future 
reference.  Keep in mind that when you output the report to any of these file formats, it’s 
possible that the layout might not remain intact.

If you do select Output To, the system will first prompt you to select the type of file you 
want to save it as and will then have you specify a location on your hard drive where the 
file will be saved.

To close the report and return to the main menu, just select Close.

Fig. 4.2

The Summary Spreadsheet is an informative tool for analyzing all the speed survey 
locations in the system.

4.2 Highlight on GIS Map

If you are using the Speed Survey System in conjunction with Crossroads Software’s 
Traffic Collision Database, you can have the system highlight the survey locations on a 
GIS map.  The map can be viewed with ESRI’s ArcView.  

From the main menu of the Speed Survey Analysis System, click on the Highlight on 
GIS Map button.

A message pops up, asking, “Calc Stats and prep Speed Survey Info to be highlighted 
on the GIS Map for all locations in the database?”

Click on “Yes” to proceed (”No” cancels the process).
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ESRI’s ArcView and GIS Mapping
Once you have opted to highlight the speed survey data on a GIS map, you must open 
ArcView by double-clicking the ArcView icon on your dekstop or by going to the Start 
Menu in Windows, then to Programs, then to the ESRI folder, and then to the ArcView 
option.

Next, you need to open a project.  From the File menu at the top, select Open Project, 
locate the GIS folder in the Crossrds directory, select the crossrds.apr, and then hit 
OK.

If you have already used the Traffic Collision Database and ArcView, it’s possible that 
you have a “Crossroads Mapping” icon on your computer that automatically opens the 
crossrds.apr in ArcView.  If this is the case, just double-click the Crossroads Mapping 
icon to open the project.

With the project open, you will need to refresh, or update, the map to display the current 
speed survey data.  Click on the Crossroads menu at the top and select “Speeds” (Fig. 
4.3).

Fig. 4.3

Selecting “Speeds” from the Crossroads menu places the speed location information on 
the GIS map.  The map itself illustrates survey locations and data with color-coded 
symbols.  Use the legend on the left of the screen to read these symbols (each portion 
of the legend is refreshed when you select a specific report from the Crossroads menu).

The legend itself can be modified.  Double-click on a section of the legend to open the 
Legend Editor.  In some cases, you might have to change the color scheme if several 
values in the map share the same color.
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Labeling Street Names
Users have the option of setting up ArcView to display street names.  The streets can 
be labeled all together or individually.  Click the Streets section in the Legend (but do 
not click the checkbox -- that will turn the Streets “off”).  Open the Theme menu and 
select Auto Label.  In the Label field, open the drop-down menu and scroll down until 
you find “St_name.”  Highlight “St_name” to select it and hit OK.

If the font of the street name labels is too large, change the font and its size by opening 
the Window menu and selecting Show Symbol Window.  Click on the “ABC” icon and 
then change the font and the size.

Click the “ABC” (font) button 
on the toolbar to access font 
settings.

Select a new font in the font 
window and change the size 
in the size field.

ArcView will not automatically refresh the GIS map after a change in font size.  To 
implement the change, go to Theme and select Remove Labels.  Then choose the 
Auto-Label feature again, make sure the “St_name” is in the Label Field, and click OK.  
(ArcView selectively places street names and typically will not display each and every 
street name.  The names that display depend partly on the layout of the data and partly 
on the scale of the zoom.  If you need all street names, you will have to zoom in on 
specific areas of the map and change the font size.)

Labeling the Streets Individually
To label the streets one by, select the Label tool.

Next, moe the Label icon to a particular street on the map and click once to bring up the 
street name.
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Once you have established a GIS map with the color scheme, font, and speed survey 
information that you need, you can produce a GIS map layout like the one shown in Fig. 
4.4 below.  Consult the ESRI ArcView GIS User Manual for details.

35


